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INVITATION TO SUBSCRIBE
If you have new faculty joining your department this semester, please share this issue of CITations with them and encourage
them to subscribe. CITations is the only electronic newsletter that covers campus IT news of interest to UNC-Chapel Hill
faculty and staff. CITations welcomes announcements from all UNC-Chapel Hill campus organizations involved in instructional
and research technology.
CAMPUS NETWORK AFFECTED BY COMPUTER WORMS/VIRUSES
ITS anticipates that it will take approximately two weeks to identify, patch, and clean all systems that have been affected by
the recent worms and viruses. ITS has found that an infection rate of as little as 2% can have a severe adverse effect on
network availability. ITS and your departmental IT support groups are taking aggressive actions to identify and repair systems
with the worm.
Nonetheless, we expect network availability to be adversely impacted for some or all students, as well as other members of
the campus community.
If you are requiring online assignments, discussions, and quizzes during the first few weeks of classes, you should keep the
status of the campus network in mind.
In the case that the network is not functioning as it should, you may want to:
-- allow students more time to access and submit online assignments.
-- consider accepting hard copy assignment submissions.
-- be prepared to switch to alternative methods for communication, access to course materials and readings, and completion
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of assignments outside of class. For example, you may want to provide students with a print version of the syllabus covering
the first two weeks.
-- during class, be prepared to use alternative methods for presentations and collaboration that depend on the network.
-- realize that regular face-to-face office hours become even more important if students are not able to communicate with you
through email or other online methods.
For the most current information on the status of the campus network, go to: http://help.unc.edu, and select the link at the
top of the page under the "Breaking News" heading. If you or your students have any questions, call 962-HELP for assistance.
USE REMEDY TICKETS TO ASSURE QUICK RESPONSES
At night and over weekends, if you experience a problem with an ITS application, you don't have to wait until regular business
hours to report the problem. Many applications are considered mission critical, with staff assigned to keep them running
regardless of the day or time you report a problem. Rather than sending email to a contact at the supporting office, you can
use ITS's web-based Remedy system to report the problem so that the correction process can begin right away. Remedy is
designed to forward problem "tickets" to an ITS support group. So if your usual support person is unavailable, backup staff will
handle the ticket.
To use Remedy to report a service failure go to http://help.unc.edu, click "Submit/Update a help request," fill out the form,
and click the "Submit" button. Your ticket will be assigned to the appropriate group within 30 minutes. If you are unable to use
Remedy, call the IT Response Center at 962-HELP, and they will submit the Remedy ticket for you.
BLACKBOARD 6 TRAINING
Introduction to Blackboard 6.0
For instructors, teaching assistants, and IT support staff, this course focuses on the basics of 1) posting content to Blackboard
sites, 2) using Blackboard's communication tools, 3) customizing sites, and 4) controlling access to them. Blackboard's
strengths and limitations as a courseware platform will also be discussed. Attendees are encouraged to bring their course
materials with them on disk.
To enroll in this class, go to http://help.unc.edu/tracs/ and click the class name. Then click on the [enroll] link for the session
you want.
CAMPUS COMPUTING POLICY TALK
The September meeting of the UNC-Chapel Hill Scholarly Communication Working Group will feature a discussion on campus
computing policies. Our guest speaker will be Jeanne Smythe, Director of Computing Policy. Jeanne's office deals with campus
computing as it relates to public record and privacy, security, accessibility for the disabled, appropriate use, and copyright. All
faculty, staff, and students are invited to attend.
When: Tuesday, September 9, 12 noon - 1 p.m.
Where: 2nd Floor Conference Rooms, Davis Library
The Scholarly Communication Working Group is sponsored by the Odum Institute. For more information about the group, go to
http://www.unc.edu/schol-com/.
CAMPUS INTEGRITY INITIATIVE
Internet Impact: The Internet and the Social Sciences Working Group is planning a fall symposium that will incorporate
integrity as a theme. As a prelude to this symposium, the group's September meeting will feature Randi Davenport, Associate
Director of the Johnston Center for Undergraduate Excellence, and Judith Wegner, Chair of the Faculty Council. They will
describe the campus's integrity initiative, and the group will discuss the interaction between integrity and the
Internet/technology.
When: Wednesday, September 10, 11 a.m. - 12 noon
Where: Phillips Hall conference room (in Phillips sub-basement)
Directions: enter Phillips through the side door near Sitterson Hall, go through the 3rd door on your left, pass through the
office, and go down the stairs that are immediately on the left.
All faculty, staff, and students are invited to attend.
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Internet Impact is sponsored by the Odum Institute. For more information about the group's activities and to join the group's
mailing list, go to http://www.unc.edu/internetimpact/.
If you have any questions about the meeting or the working group, contact the chair, Elizabeth Evans, 962-6344,
evans@unc.edu.
CAROLINA CALENDAR MEETING
With the closing of Arts Carolina, it's more important than ever to keep our online arts calendars and websites up to date so
that we may publicize our excellent arts programs to the university and the wider community that we serve.
A meeting will be held on Thursday, September 25, from 3:30 p.m. - 4:30 p.m. in Toy Lounge, Dey Hall, where you can learn
more about the online arts presence and how you can help. This meeting is open to everyone who has been using Carolina
Calendar, as well as those who had relied on Arts Carolina. We will explain how the online calendar and a new "Arts at
Carolina" web page will work together to help our audiences learn more about our programs and scheduled events.
Please plan to attend or to send a representative from your program. You may RSVP to Elizabeth Evans at 962-6344 or by
email to evans@unc.edu.
CAMPUS LIBRARIES PROVIDE SPATIAL DATA FOR RESEARCH
UNC-Chapel Hill Libraries actively collect spatial data from governmental sources (federal, state, and local) and commercial
vendors. The GIS (Geographic Information Systems) Data Finder is a finding aid that helps library patrons find and evaluate
our spatial data holdings to use in their research.
The GIS Data Finder allows patrons to look for spatial data in a variety of ways. For those patrons who would like to browse
our collection to see what types of data are available, the "Browse data layers by thematic category" option would be
appropriate. This option provides a listing of thematic categories such as "States," "Roads," or "Soils." After a category is
selected, a listing of data that falls into that category will be displayed. Each data record can then be expanded to provide a
comprehensive description of each data layer.
Patrons who are looking for a specific data layer may prefer the "Search the GIS Data Finder" option. This option allows for
keyword searches of spatial data. Data holdings can also be searched by Geographic Area of Interest. After a search is
performed, a listing of data that meets the search criteria will be displayed. Each of these data records can also be expanded
to provide a comprehensive description of each data layer.
For more information about the GIS Data Finder, See the Frequently Asked Questions at
http://www.lib.unc.edu/reference/gis/datafinder/index.html.
-- Amanda Clarke Henley, Geographic Information Systems Librarian tel: 919-962-1151; email: ahenley@refstaff.lib.unc.edu
JULY 2003 ISSUE OF CIT INFOBITS
CIT Infobits is an electronic service of ITS/CIT. Each month the CIT's Information Resources Consultant monitors and selects
from a number of information and instructional technology sources that come to her attention and provides brief notes for
electronic dissemination to educators. To subscribe link to http://mail.unc.edu/lists/read/subscribe?name=infobits.
Articles in the July 2003 issue (http://www.unc.edu/cit/infobits/bitjul03.html) include:
U.S. Distance Education Survey
Distance Learning Resources
Information Visualization Tools Are Improving
Commercial vs. Research Library Online Reference Services
Perennial Plagiarism
Spam Wars
All back issues of CIT Infobits are available on the Web at http://www.unc.edu/cit/infobits/index.html.
UNC-CHARLOTTE WORKSHOP ON LEARNING COMMUNITIES AND RETENTION
The Office of Academic Affairs at UNC Charlotte is hosting a one day workshop on Learning Communities and Retention. It will
be held on Friday, September 19,2003 at UNC Charlotte and will feature Ms. M. Stuart Hunter, Director of the National
Resource Center for First-Year Experience and Students in Transition, the University of South Carolina, and Dr. Bobby Kanoy,
Associate Vice President for Academic and Student Affairs, Access and Outreach for UNC. For more information go to
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http://www.uncc.edu/academic_affairs.
ITRC TIP: COLOR-CODE YOUR EXCEL SHEET TABS
In Microsoft Excel 2002, you can color-code sheet tabs for easier identification or grouping of related sheets. Here's how:
1. Select the sheets you want to color by holding down the CTRL key and clicking the tabs.
2. On the Format menu, point to Sheet, and then click Tab Color. You can also right-click the sheet tab and then click Tab
Color.
3. Click the color you want, and click OK.
ITRC TIP: CREATE A PHOTO ALBUM PRESENTATION IN POWERPOINT 2002
Did you know you could use Microsoft PowerPoint 2002 to create a photo album? Here's how:
1. On the Insert menu, point to Picture, and then click New Photo Album.
2. In the Photo Album dialog box, you can choose to add pictures from your hard disk or a peripheral device, such as a
scanner or digital camera. To add a picture from a file or disk, do the following:
a. Under Insert picture from, click File/Disk.
b. Locate the folder or disk that contains the picture you want to add to your photo album, click the picture file, and then click
Insert.
3. Repeat Step 2 for as many pictures as you want to add to your photo album. Or to capture them all at once, hold down the
CTRL key, click each picture file you need, and then click Insert.
4. Next, specify the look of the album under Album Layout.
5. Then click Create.
Note: If you want to change or update your photo album after you have created it, use the Format Photo Album dialog box
from the Format menu.
For more computing assistance, contact the Information Technology Response Center, Undergraduate Library.
Walk-in Hrs: 7:30 a.m. to 5 p.m.
Submit a help request on the Web: https://www.unc.edu/ar-bin/websub/index.pl
Tel: 962-HELP -- 24 hours/7 days a week
Email: help@unc.edu
ITRC website: http://www.unc.edu/atn/itrc/

CITATIONS TIPS ARCHIVE
The ITRC, CBT, and Lyris tips published in CITations are archived on the Web, so you can locate tips without having to search
through all the back issues. The tips archive is at http://www.unc.edu/cit/citations/tips.html.

CONFERENCE ANNOUNCEMENTS
Stay informed about technology conferences with the CIT's "Education Technology and Computer-Related Conferences" at
http://www.unc.edu/cit/guides/irg-37.html and "Calendar of World-Wide Educational Technology-Related Conferences,
Seminars, and Other Events." The calendar is at http://confcal.unc.edu:8086/.

2003 CITATIONS PUBLICATION SCHEDULE
January 10 & 24
February 7 & 21
March 14 & 28
April 11 & 25
May 9 & 23
June 6 & 20
July 11 & 25
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August 8 & 22
September 12 & 26
October 10 & 24
November 7 & 21
December 5 & 19
CITations welcomes announcements from all UNC-Chapel Hill campus organizations involved in instructional and research
technology. To have an announcement considered for publication in CITations, send email to Carolyn Kotlas,
kotlas@email.unc.edu, or call 962-9287. The deadline for submissions is 11:00 a.m. the day before the publication date.

HOW TO SUBSCRIBE OR UNSUBSCRIBE TO CITATIONS
CITations is published twice a month by the Center for Instructional Technology. Back issues are available on the CIT website
at http://www.unc.edu/cit/citations/.
For more information about the CIT, see our Website at http://www.unc.edu/cit/ or contact our office at 962-6042.
To subscribe to CITations, link to http://mail.unc.edu/lists/read/subscribe?name=citations.
To unsubscribe to CITations, send email to listserv@unc.edu with the following message:
unsubscribe citations
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